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Getting Started: Introduction 
 
Welcome to STX 
Thank you for purchasing STX, the most intuitive, user-friendly management 
software available anywhere.  
 
Please take the time to review the items in this Getting Started section to get the 
maximum benefit from your STX experience. 
 
STX Software Commitment 
1. Provide you with a complete, fully functional, working copy of our software. 
This includes a complete, comprehensive and easy to read Manual, which is 
available for you to print from the STX software CD or download from our 
website, www.STXSoftware.com.  
 
PERMISSION: STX Software, LLC gives permission to print the manual 
from a downloaded file and/or the STX software CD. Reprinting or copying 
of the manual is permitted and is for use by the owner of the software 
license only. 
 
2. Correct legitimate software bugs when they are found and documented and 
make the corrected software available to you. 
 
3. Provide prompt and professional technical support for STX at a reasonable 
fee. It is our obligation to provide technical support for any software created 
and/or written by STX Software, LLC. Please see the Limited Software 
Support section for important information. 
 
Owner’s Commitment 
1. Learn to use and properly maintain your computer system. This includes 
making sure you have enough memory installed, your network is working 
properly at all times, and your OS X software is always upgraded to the most 
current version, as well as any other third party software applications you may be 
using on your computer(s). 

 
2. Take the time to learn STX yourself and personally train your key employees. 

 
3. Designate only experienced employees to request technical support. 
 
4. Keep your STX software updated to the most current version and keep the 
latest version readily accessible to employees who request technical support in 
the event they may need to reload the software. 
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5. Perform daily backups of your STX data to an external source in order to 
protect from accidental loss of data – use a CD, USB drive, etc., that can be 
removed and kept off-site in the event the company or company's property is 
stolen, damaged or destroyed.  
 
Your STX data contains extremely important information that is vital to the 
success of your business. Always safeguard your STX data by routinely doing 
daily backups at the end of each and every business day. Failure to properly 
back up your data may result in lost or corrupted data.  
 
STX Software can provide only limited data recovery (for a fee) should your data 
be compromised and you have no recent backups. This could result in your 
business being "down" for several days without access to your STX program.  
 
6. Review your STX data on a regular basis to determine that the computer 
policies you have in place are being followed and to check the integrity of your 
data. 
 
7. Document and report all software problems to STX Software Technical 
Support department by calling 800.766.4778 ext. 2 or email  
support@STXSoftware.com. 
 
8. Document and forward any ideas for additions or enhancements to STX to the 
Technical Support department by calling 800.766.4778 ext. 2 or email 
support@STXSoftware.com. 
 
9. Find a local Apple dealer/distributor/specialist who can help you with any 
hardware needs and/or challenges. 
 
10. Find a local Network Technician who specializes in networking with Apple 
computers. While the STX Software Support technicians know how a local 
and/or remote network should be set up, they cannot help troubleshoot problems 
with a network. 
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Limited Software Support 
Documentation 
STX Software offers a wide array of documentation in order to help you 
accomplish and understand the functions of STX. This documentation includes 
the STX Manual, STX Help found within STX, instructional documents contained 
on the STX installation CD, as well as STX FAQ/Info documents also found on 
the STX installation CD. These are designed as tutorials to promote a better 
understanding of how STX works, why some functions are designed the way they 
are, and to walk you through setting up your information. Although the STX 
Manual is very detailed and contains many examples, we cannot include every 
scenario since each business is unique unto itself.   
 
Software Support 
Technical support is available for currently supported software created or written 
by STX Software. The technical support department is not obligated to help with 
any of the following areas:  STX Training, hardware, peripheral hardware, third 
party software, Mac OS X functions, or networking. Once our support technician 
determines that the challenges you are experiencing lie outside the STX 
Software platform, they will offer advice and/or instruction on what you should do 
next. Because the STX support technicians are only versed in the operations and 
functionality of the STX Software platform, it is not the responsibility of the 
support technician to offer any further troubleshooting relating to the challenges 
outside of the STX Software platform. 
 
STX Training 
Technical support is not intended to take the place of receiving formal training for 
your STX software. Although our technical support team is qualified to answer all 
of your questions, we like to reserve their time for our clients who are 
experiencing technical difficulties. The Education Department is available for all 
of your training needs through phone training and webinars. The per hour rates 
for phone training and/or webinar are significantly less than the technical support 
rates, so it is to your advantage to schedule phone training with a member of the 
Education Department. We believe that knowledge is power, and that having the 
knowledge on how STX works will give you the power to run your business 
successfully. Training on STX is an investment in your business and in your 
future. The more you know about STX and what it can do for you, the better it can 
help you grow your business. If you desire on-site training, please contact your 
STX Software Sales representative for pricing. 
 
Hardware 
Although STX Software makes recommendations as to what hardware you 
should use with STX, we are not responsible for the use and/or maintenance of 
any hardware and are not obligated to support or troubleshoot any hardware 
related challenges you may be experiencing. 
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Peripheral Hardware 
Peripheral hardware is defined as, but not limited to, any piece of equipment that 
connects to the computer, such as a printer, receipt printer, label printer, cash 
drawer, barcode scanner, magnetic card swipe, as well as any type of removable 
media including backup drives and external hard drives. It is not necessary to 
have any of these in order for STX to function properly, however, STX is 
designed to work with these types of peripheral hardware. If you choose to 
purchase one or more pieces of peripheral hardware, it is not the responsibility of 
STX Software to maintain, support, or troubleshoot challenges related to them. 
STX Software may recommend specific brands for selected types of peripheral 
hardware when we find they work best with Apple products as a whole.  
 
Third Party Software 
Third Party Software is any software package other than that created or written 
by STX Software. Some examples of Third Party Software include Mac OS X, 
TreAura, Word, Excel, MYOB Accounting, CheckMark Payroll, just to name a 
few. STX Software may suggest the use of one or more of these software 
packages when we find they work best with Apple products as a whole, but can 
in no way be held accountable for the use, maintenance, support or 
troubleshooting of any challenges you may be experiencing.  
 
Networking & Remote Access 
STX Software can offer guidelines for you to follow when setting up and using a 
local network and/or gaining access to your STX data from a remote location. 
However, STX Software is under no obligation to help with the actual setting up, 
maintaining, supporting or troubleshooting of any challenges you may be 
experiencing with your network, whether local or remote. 
 
Automation Schedule 
Taking the time to learn and properly set-up STX will pay huge dividends in the 
efficient and comprehensive use or your software. Understanding all of the 
features that are available in STX and giving some thought to how you may use 
them will allow you to collect complete and usable data from Day One. 
 
After acquainting yourself with these features, set aside the appropriate amount 
of time to write down or accumulate all of the data you will need to complete the 
set-up portions of STX. After entering your data, print and review reports to make 
sure everything was entered correctly. 
 
Start using STX right away, but don’t try to implement all parts of the program at 
once. Make sure you and your key employees are comfortable with a new feature 
before moving on and review any data entered to make sure it serves your 
needs.  
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Do not attempt to move your entire manual (paper) appointment book to STX at 
one time. Choose a "target" date, perhaps when your manual book ends, and 
start booking new appointments after that date in STX. This allows you to start 
slow and increase your automated booking experience as the designated date 
approaches.  
 
If you feel comfortable with booking through STX, you may want to move the 
target date forward as many days as desired. This procedure will allow you to go 
live with automated booking sooner, while at the same time feeling comfortable 
with the switch. 
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Getting Started: Networking 
 
Introduction to Networking 
Networking allows your data to be shared by multiple computers running STX at 
the same time. Each computer can be used to simultaneously add, change and 
delete information and these changes will appear on all of the computers. 
 
Networking significantly increases the volume of data that can be entered and 
viewed at any one time and allows STX to operate efficiently in even the largest 
of companies. Networking also allows an owner or manager to work with STX 
from an office or remote location. 
 
Connecting Your Computers 
Your computers can be connected using Ethernet cables that plug into an 
Ethernet port on each computer (recommended) or by wireless connections 
using radio waves (not recommended). 
 
Using a special crossover cable, Ethernet cables can run directly between 2 
computers if you only have a 2-computer network. Otherwise, each Ethernet 
patch cable will connect to a hub, switch or router.  A hub or switch works fine if 
you are only connecting computers in your local network. A router is needed if 
you also want to connect your network to other networks or to the Internet.  
 
While a wireless network is not recommenced, it requires that each computer 
have a wireless card and, in the case of more than 2 computers, you will also 
need a wireless access point which functions much like a router. We do NOT 
recommend wireless networking for computers that are booking appointments 
and processing transactions because of potential speed and connection issues. 
These computers should be connected to the server by Ethernet cables and a 
hub, switch or router. If additional computers are to be connected via wireless, 
the access point should be connected to the hub, switch or router.  
 
Client-Server 
Server refers to the computer on which you have installed STX and "houses" the 
data files. This computer is responsible for sharing the data files with other 
computers on the network. If you have only a single computer running STX, this 
is also considered the Server, or may be called a Stand-Alone computer. Client 
refers to the computer where only the STX application is installed. This computer 
accesses the data files that are stored on the Server. 
 
A server that only "houses" the data files and does not run the STX application is 
called a Dedicated Server. This is the most efficient server configuration and 
should be considered for larger networks. 
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STX Networking 
STX is a true client-server application that takes full advantage of the power and 
security built into the client-server architecture. It will work equally well on one 
computer or on a large network of computers. Note: There can only be ONE 
server with STX data on your network. 
 
While STX works well over a local or remote network, it is very important you 
contact a network technician who specializes in Mac computers to help you get it 
set up. STX Software representatives are certified and knowledgeable with 
every aspect of the actual STX software itself, however, setting up a network 
involves areas outside the STX software and should be handled by a network 
professional. 
 
When you purchased STX you were licensed for a certain number of seats. A 
seat is defined as a computer running STX and accessing the STX data files. If 
you are licensed for 4 seats and have a total of 6 computers (including the 
server), only 4 of the 6 computers can be running STX and accessing the STX 
data files at the same time. To find the number of seats you are licensed for, see 
STX: Registration. If you wish to purchase additional seats, please contact STX 
Software or your local STX Software distributor. 
 
Working from a Remote Location 
Because STX uses IP sharing, you can connect from a remote location by 
entering the IP address of the server as long as both the server and remote 
computer are using a broadband Internet connection. If your STX server is 
behind a firewall via a router, you will need to open ports 9090 and 20260 and 
forward these ports to the server’s internal IP address using TCP/IP protocol. 
You will use the external IP address assigned by your Internet Service Provider 
when connecting from your remote computer. To obtain the external IP address 
on the server, go to www.whatsmyipaddress.com from the server computer. The 
external IP address of the computer will be shown to you on the screen. You will 
need to license sufficient seats to include your remote connection. 
 
If you do not have a broadband connection at both ends, you will need to 
purchase remote access software such Apple Remote Desktop Server, or 
Timbuktu Pro. Please note that this type of access takes control of the server and 
it cannot be used until the remote session has ended. 
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Getting Started: Menus & Toolbars 
In STX, you have the choice of using pull down menus, visual toolbars, or a 
combination of the two. 
 
Menu Bar 

 

   
 
Click on any item in the menu bar to pull down additional menu choices.  
 
Note: If menu bar items or menu items are not highlighted (dark) they are not 
available for use. This may be because of password permission or because the 
item is not currently applicable. 
 
STX Menu 

 
Click on any item in the menu to perform the associated function or to bring up 
the associated window. Click on Preferences to edit STX preferences. Click on 
Registration to enter new registration numbers (license key). Click on Quit STX to 
exit the program.  
 
Note: Keyboard shortcuts, such as Command-H, allow you to choose certain 
menu items without actually pulling down a menu. These shortcuts, if available, 
are listed in the menus to the right of the menu item text. You may enter these 
shortcuts by holding down the Command (Apple) key while pressing the other 
key(s). 
 
 
 
 
 



     Getting Started: v198 
© STX Software, LLC 2003 - 2013 

10 

File Menu 

 
Click on any item in the menu to perform the associated function or to bring up 
the associated window. Click on Log Out to bring up the Log In window to log in 
another employee.  
 
Click on Print to bring up the Reports window. 
 
Edit Menu 

 
Click on any item in the menu to perform the associated function. These menu 
items allow you to edit text in fields. Cut removes the selected text from a field, 
Copy leaves the selected text in a field and Paste copies the cut or copied text to 
another field. Undo, if active, will return a changed field to its original unedited 
content. Clear removes the selected text from a field. 
 
Setup Menu 

 
Click on any item in the menu to bring up the associated window. NOTE: The 
menu item Change Owner Password is only activated when you are logged into 
STX as the OWNER. You must know the current OWNER password in order to 
change it to a new password. It is extremely important that no member of your 
staff know what the OWNER password is since they could come to this area and 
change the password without your knowledge, thus blocking you from your 
access to the program. 
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Appointments Menu 

 
Click on any item in the menu to bring up the associated window. 
 
Transactions Menu 

 
Click on Transactions in the menu to bring up the transactions window. Click on 
No Sale to open the cash drawer. Notice the keyboard command of Apple-O to 
opening the drawer without having to use the menu. Click on Gift Management 
to bring up the gift management window. 
 
Client Menu 

 
Click on any item in the menu to bring up the associated window. 
 
Inventory Menu 

 
Click on Purchase Orders in the menu to bring up the purchase order window. 
 
Payroll Menu 

 
Click on either item in the menu to bring up the associated window. 
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Format Menu 
Click on any item in the menu to perform the associated function. These text 
formatting menu items are only active when text is highlighted in certain areas of 
the program, namely when customizing a Gift Certificate template in Setup: 
General. 

  
The Font menu allows you to choose the font, font size, and text color and to 
format text as bold, italic, underlined or other available format. 
 
The Text menu allows you to align the text to the left, right, or center in the text 
field, or to justify the text so it expands to fill the line. 
 
Window Menu 

 
Click on any item in the menu to perform the associated function.  
 
Minimize Window will shrink the active window and place it into the Dock. To 
bring the window back, click its icon in the dock and it will appear in full view.  
 
Zoom Window will enlarge the active window so it will fill the entire screen.   
 
Bring All to Front item will bring all program related windows to the front, so 
they will no longer be overlapped by other windows from different programs. 
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Users Menu 
You must have each employee and the password security access already set up 
in order to benefit from the Users menu features. 
 

 
Click on Switch User (or use the keyboard command of Apple-U) to switch 
between the currently logged in user and a different user. The user currently 
logged in will show in gray and will have a checkmark next to their name. In the 
picture above, the Owner is the currently logged in user. All employees with a 
password will be listed for you.  
 

    
If an employee has a checkmark next to their name, that employee is also logged 
in as a user, but is not the Current logged in user. The user appearing in Gray 
text and a checkmark is always going to be the most current logged in user.  
 

    
After each user has logged out by going to the File menu to LogOut, the 
OWNER can select the Clear Menu option to remove all employee names from 
the list, leaving only the OWNER remaining. 
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Help Menu 

 
Click on STX Help in the menu to bring up this on-line help system. The following 
screen will appear. 

 
Once the STX Help screen appears, click on one of the Help Topics listed on 
the left side of the screen. In the following example, Getting Started was clicked. 

 
On the right, a list of areas pertaining to the Help Topic chosen will appear. Click 
an area on the right to see the information regarding the area chosen. In the 
following example, Menus & Toolbars was clicked. 
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As you can see, the information contained in the STX Help screen is much like it 
is here in this section of the STX Manual. All information is available to you in 
either location.  
 
It is recommended you keep the STX Help minimized in your dock for easy 
access throughout the day.  

 
To minimize the STX Help, click the yellow gumdrop in the upper left corner…    

 
…or use the Window menu and select the Minimize option.    

 
When you are finished with the STX Help, go to the Help Viewer menu and 
select Quit Help Viewer.  
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Main Toolbar 

 
Click on the Setup icon to reveal the setup toolbar, the Appointment icon to 
reveal the appointment toolbar, the Client icon to reveal the client toolbar, the 
Payroll icon to reveal the payroll toolbar or any other icon to bring up the 
associated window. The setup, client, and payroll toolbars will disappear after the 
associated window is opened. 
 
Setup Toolbar 

 
Click on any icon to bring up the associated window. NOTE: The item Password 
is only activated when logged into STX as the OWNER. You must know the 
current OWNER password in order to change it to a new password. It is 
extremely important that no member of your staff know what the OWNER 
password is since they could come to this area and change the password without 
your knowledge, thus blocking you from access to the program. 
 
Appointment Toolbar 

 
Click on any icon to bring up the associated window. 
 
Client Toolbar 

 
Click on either icon to bring up the associated window.  
 
Payroll Toolbar 

 
Click on either icon to bring up the associated window. 
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Getting Started: Logging In & Out 
 
Purpose 
Each person within your company, whether owner or staff member, must log in 
and out to preserve password permissions. Some areas of STX will actually track 
and show which person was logged in at the time a record was created and/or 
changed. 
 
Logging In 

 
Type OWNER or your employee ID. Type your password, which is case 
sensitive, and click Log In. 
 
Click Quit to quit STX. 
 
Your license to use STX has an expiration date based on your status. Rental 
licenses expire at the end of each rental period and all licenses expire on a 
periodic basis. This is done to ensure you are using a currently supported version 
of STX and that STX Software is maintaining updated information on your 
company. 
 
As a client in good standing, STX Software will send you a new license before 
your current license expires, and once you notify us that the current license is 
about to expire. If you have any questions or wish to request a new license, 
please contact STX Software by calling 800.766.4778. 
 
STX includes a built-in alert that informs you when the current license will expire. 
Each day that goes by without entering an updated license, the license expiration 
message will continue to appear, counting down how many days are left before 
expiration.  
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The license expiration message will start appearing at least 30 days before the 
current license expires. 

 
This license expiration message will appear on the day your current license 
expires.  

 
Beginning twenty-eight (28) days before your current license will expire, this 
sheet will appear each time you log in to STX. This sheet will appear each day 
until you either enter a new license, or the license expires. Click Renew / Enter 
New License to enter your new license manually or to renew the license online.  
 
Click OK to start STX without entering a new license. 

 
Once your current license has expired, you will not be able to use STX until a 
new license is entered. Click Renew / Enter License to enter your new license 
manually or to renew the license online. Click Quit to quit STX.  
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Renew / Upgrade Online… allows you to either renew your STX License online, 
or to purchase additional STX features via the STX Online Store.  
 
Additional STX features include upgrades to licensed employee levels, additional 
seats for adding computers to a network, and STX Modules such as the Rewards 
Program and Biometric Security.  
 
To purchase the STX modules, click Renew / Upgrade Online… or contact our 
sales department at 800.766.4778 and a member of our team will be happy to 
assist you. 
 
Clicking Renew / Upgrade Online… will automatically update the License Key 
if the current license key is older than what our records show. Once the new 
license key has been updated, click Apply.  
 
If you are currently using a temporary – or Demo – license, the following alert will 
appear when clicking Renew / Upgrade Online… 

 
Follow the instructions on the alert and then Click OK. Once you receive your 
personalized license, you will need to enter the license information manually.  
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Logging Out 
To quickly log out the employee currently logged in, without the ability to switch to 
the employee later, you will simply log the employee out of STX and log the next 
employee in. 

 
To Log Out of STX, it is not necessary to actually Quit the program. Pull down 
the File Menu to Log Out. 
 

 
Once the Log In screen appears, type the next employee’s ID code and 
password. Click Log In to log in the employee. Click Quit to quit STX. 
 
Rather than logging each employee in and out to switch who is logged in, an 
alternative would be to use the Switch User feature found in the Users menu, 
explained earlier in this chapter. 
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Getting Started: Preferences 
 
Purpose 
Preferences tell STX how you wish to use the program. Based on your selections 
in this window, various parts of STX will function in different ways. 

 
Pull down the STX menu to Preferences. 
 
System 

 
Database server name or IP address tells you which computer contains the 
STX databases, or where the data is located. It is entered when you first install 
STX and will not be modified unless you change your server computer, or the IP 
address of the server changes. Please note: A static IP address is recommended 
when using STX on a network. A Static IP Address never changes.  
 
If you have a server with 1 or more workstation (client) computers, the IP address 
showing here on the server should be 127.0.0.1. This tells STX to look at the 
"local" hard drive, meaning look at the computer we are using to look at this 
screen right now. If you have just a single, stand-alone, computer, the IP address 
showing here will also be 127.0.0.1 for the same reason. If you are currently 
looking at this screen from a workstation (client) computer, the IP address 
showing here will be the server's IP address.  
 
Note: If you make any changes to the name or IP address in this screen, 
the change will not take effect until you exit and then restart STX. 
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Secure System when the computer is inactive for: 
When the Secure System option is set to come on, it will fade out the entire 
application and put up a log in window once the system is idle for the length of 
time specified. Anyone with a password may log in at this time. 
 
Require password to edit: If Appointments is checked, the currently logged in 
employee will be forced to re-enter Emp ID and password to create or edit an 
appointment. If Client Visits is checked, the currently logged in employee will be 
forced to re-enter Emp ID and password to create or edit a client visit transaction. 
 
NOTE: This feature stops other users from creating and entering transactions 
and/or appointments while logged in under someone else's password. It will 
require the user to Log In for each Client Visit transaction as well as each time an 
appointment is created. The Log In screen will only accept the employee ID and 
password of the user currently logged in. This is to 'prove' they are who they say 
they are. 
 
Appointments 

 
Combine Appointment Services: 
Determines whether a client's services should be considered as one multi-service 
appointment or not. This preferences option only affects services booked for the 
same client on the same day. You have 3 choices for combining appointment 
services or not. 
 
- Always: Always combines client's services into one multi-service appointment 
regardless of how or when the separate services were booked for that day. 
Because the services are combined into one multi-service appointment, only one 
ticket transaction will be created for the client when the appointment is checked 
in. All services being performed will appear on the single ticket transaction. 
 
- Never: Client's services are never combined into one multi-service 
appointment. This keeps each individual service as its own separate 
appointment, regardless of how or when the separate services were booked for 
that day.  
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Because the services are not being combined into one multi-service appointment, 
one ticket transaction will be created for each individual service when just one of 
the service appointments is checked in. However, each individual service 
appointment will be checked in at the same time because they are all for the 
same client, thus creating multiple ticket transactions. 
 
- Prompt: This will prompt you with a message screen when you are booking 
more than one of the same client's services as to whether you wish to combine 
each service into one multi-service appointment, or keep them separated into 
individual service appointments. The following example shows how to combine 
appointments when the STX Preferences is set to Prompt.  

 
Click Create New to keep the services separated into individual service 
appointments. This will also keep the appointment note as well as the Visit Type 
separated. Click Add to combine the service you are currently booking with the 
service already booked to create one multi-service appointment. Click Cancel to 
return to the screen for booking the service/appointment. 
 
Choose Reminder Printer: 
Use the popup menu to select which printer you would like Reminder labels 
printed from. A Reminder label is similar to the one pictured below. 

 
The Reminder Labels can be printed from a DymoLabel Writer and fit perfectly on 
the back of a business card. 
 
Sort Appointment Builder Results by: 
When using the Appointment Builder to book appointments, the search results 
will be sorted in the order you have chosen in this screen. 

 
Sorting by Date and Time will sort the search results in chronological order.  
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Sorting by Date, Rank and Time will sort the search results first by date, then by 
the rank, and lastly by time. The Rank of an appointment time indicates which 
time slots are the "best fit" on the appointment book for the appointment to take 
place. This helps to eliminate the "swiss cheese" effect by attempting to fill holes, 
touch existing appointments, or leave multiples of the service times above or 
below what you are adding to the book. 
 
Display Employee Images on Appointment Book 

 
When checked, the employee’s picture will show at the top of the booking 
column. Employee pictures are set on the employee’s record in Setup: 
Employees.  
 
Receipts 

 
Receipt Printer:  
Allows you to select which printer you wish to have your Client Visit transaction 
receipts printed to. 
 
Receipt Font: 
Allows you to set the font used to print the receipts. To set the desired font, click 
the Select… button. 
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When the above screen appears, choose the font you wish to use for the 
receipts, then close the Fonts list window. The selected font will now appear in 
the STX Preferences screen. 

 
Be sure to restrict yourself to fixed width fonts such as Courier, Courier New or 
Andale Mono or the receipt will not display properly.  Additionally, since the 
receipts are scaled to fit the paper in the receipt printer, changing the font size 
will have no impact on the output. 
 
Receipt Options: 
Include Discount Details on Receipts will print the details of each discount 
taken for each service and/or product sold. 
 
Include Discount Summary on Receipts will print the summary of all discounts 
taken for each service and/or product sold. The summary is a grand total of 
discounts taken and shows as a Total Savings amount. 
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Getting Started: Registration 
 
Purpose 
Registration gives the server, or stand-alone computer, the information 
necessary to run the STX software including your company name, number of 
active employees, number of seats, expiration date, and the host ID for the 
computer the license was generated for. You will enter this registration 
information when you first install your software or any time you need to change 
one or more of the registered items. 
 
Renew / Upgrade Online… allows you to renew your STX License online 
or purchase additional STX features via our STX Online Store. Additional STX 
features include upgrades to licensed employee levels, additional seats for 
adding computers to a network, and STX Modules such as the Rewards Program 
and Biometric Security.  
 

 
To purchase the STX modules, click Renew / Upgrade Online… or contact our 
sales department at 800.766.4778 and a member of our team will be happy to 
assist you. 
 
Modules listed in GRAY are items you are currently registered to use. The STX 
Online Store will only allow you to purchase items you have not already 
purchased. 
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Clicking Renew / Upgrade Online… will automatically update the License Key 
if the current license key is older than what our records show. Once the new 
license key has been updated, click Apply.  
 

 
NOTE: This registration information is used by and entered only on the 
server, or stand-alone, computer. This information is never entered or 
used by the workstation (client) computers. If you are making changes to 
the registration information, you must first Quit STX on each workstation 
(client) computer and make changes on the server computer. Once all 
changes are made, you may launch STX on the workstation (client) 
computers again. 
 
Entering a new license 
If you are entering a new license manually, type or copy/paste your Company 
name and license Key exactly as shown or given to you by STX Software. Click 
Apply once the information is entered. Click Cancel if you make a mistake or 
wish to start over.  
 
You may wish to renew the license online by clicking the Renew Online button. 
This will automatically update the License Key if the current license key is older 
than what our records show. Once the new license key has been updated, click 
Apply.  
 
If your license cannot be renewed online, the following screen will appear. 

 
Click OK to manually enter the license information. If you entered the license 
information incorrectly, the following sheet will appear. 
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Click OK. Check the information at the bottom of the registration window to make 
sure it is correct. If it is not correct, try entering the company name and key 
again. If it is still not correct, please contact STX Software. 
If you entered the license information correctly, the following sheet will appear. 

 
Click OK. Close the Preferences screen when you are finished. 
 
 
License Definitions 
Host ID: 
This is the unique ID of your server's (or stand alone) Ethernet adapter or built-in 
port. This ID is known as either the Ethernet ID or the Ethernet Address. All STX 
Licenses are based on the Ethernet ID of your server (or stand-alone) computer. 
Because of this, it is imperative you supply the correct Ethernet ID to STX 
Software when requesting your personalized STX License. 
 
Expires: 
This is the expiration date of your license to use STX. Normally used to enforce 
payment due dates in lease or rental contracts, all STX Licenses will have an 
expiration date. If you are not leasing or renting the software and are in good 
standing, STX Software will send you a new license before your current license 
expires. Please contact STX Software if you have questions or wish to request a 
new license.  
 
Active Employees: 
This is the maximum number of active, not terminated, employees you are 
licensed to have listed in STX. Contact STX Software or your local STX 
Software distributor if you wish to increase the maximum number of employees. 
 
# Seats: 
The maximum number of computers you may have running STX at any one time. 
Any computer logged into the STX database is using a seat. You could have 20 
computers, but if you are only licensed for 3 seats, only 3 of the 20 computers 
can be logged into STX at the same time. 
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Software Updates: 
STX Software is constantly improving STX and updates are made available for 
download, providing you access to new features and other improvements. In 
order to access these updates, a software subscription is required and can be 
purchased directly using your STX software, or by calling our corporate office at 
800.766.4778. 
 
Items Enabled 
Once you have entered your license key, this screen will always show what 
modules you have purchased and are enabled. If you do not see the word 
Enabled next to Gift Cards, Electronic Payments, Biometric Security, or Rewards 
Program, you have not purchased those modules. Online Services will show the 
word Syncing if you are subscribing to the Online Services module. Please 
contact your STX Software Sales Account Manager for information regarding 
these modules. 
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Finding the Ethernet ID (Address) to request a new license 

 
Pull down the Apple menu to About This Mac. 

 
Click More Info… 

 
On the left column under Contents, select Network and then highlight 
Locations. 

 
On the right side at the top, highlight the Automatic Location Name. 

 
In the right bottom area, scroll down and look for the Ethernet section. Search 
for the item BSD Device Name:  en0. The Hardware (MAC) Address is the 
Ethernet ID of your server computer. This is the number needed for a new 
license key. Record the Hardware (MAC) Address. Quit System Profiler. 
Phone STX Software at 800.766.4778 to request your key. 
 
Note: This address is unique to your server computer and must be 
recorded exactly as shown, 6 pairs of numbers and lower case letters 
separated by colons. 
 
The Ethernet ID can change if you get a new server or have any work performed 
on your existing server. If you have to take your existing server in for repair, 
please be sure to verify the Ethernet ID and report any changes in the number to 
STX Software. We will generate a new license based on the different Ethernet 
ID as soon as possible. 
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Getting Started: Common Techniques 
 
The following techniques are used throughout the STX program and are 
described here rather than duplicating this information in multiple sections of the 
STX Manual and/or STXHelp guide. While in the STXHelp guide, you will find 
links in several help sections that will bring you directly to the same information 
as in this section. 
 
Automatic Capitalization 
STX was designed with ease of use in mind. To that end, we feature automatic 
capitalization of the first letter of each word in text fields. In memo fields, where 
you will be typing complete sentences, this feature is disabled.  
 
The first letter following any space will be capitalized automatically as you type in 
new data. You may also capitalize other letters by holding down the shift key 
before typing the letter as you normally would. Previously typed text may be 
edited and the program will remember the edited capitalization once the changes 
have been saved. 
 
Entering Dates 
STX also features quick entry shortcuts in date fields. If the desired date is in the 
current month, just enter the day of the month (d). If the desired date is in the 
current year, just enter the month/day of the month (m/d).  
 
Only if the desired date is in another year must you enter the complete date. 
Complete dates may be entered as m/d/yy or m/d/yyyy. It is not necessary to 
enter a zero in months or days if the month or day is less than 10. If you enter a 
two-digit year (yy) check to make sure the displayed date is in the correct 
century. 
 
Navigation 

 
Use menus or toolbars to open a particular window. 
 

 
Click on tabs to change screens within a particular area of the program. 
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Click on the arrows in scroll bars to view more data by moving the data up, down, 
right or left. 
 

 
Click on the gumdrop buttons on the left hand side of the title bar to control the 
window. The red button (or Command-W) closes the window, the yellow minimize 
button moves the window to the dock and the green expand button makes the 
window larger or smaller. 
 

 
Click on the toolbar button on the right hand side of the title bar to hide or show 
the toolbar icons within a window. 
 

 
Click on the title bar of a window, hold down the mouse button and drag the 
window to a new location. Release the mouse button when the window is in the 
desired location. 
 

 
Click on the resize lines, hold down the mouse button and drag to resize a 
window. Release the mouse button when the window is the desired size. Some 
windows can't be resized. 
 
Printing 

                                   
Click Print, pull down the File menu to Print (or Command-P), or click on 
Reports in the main toolbar to bring up the list of available reports in STX. 



     Getting Started: v198 
© STX Software, LLC 2003 - 2013 

33 

Saving Data 

 
Click Save (or Command-S) to save changes you have made within a window.  
 

 
This sheet will appear if you close a window with unsaved changes. Click Save 
(or press Return on your keyboard if the Save button is aqua in color) to save 
your changes. Click Don't Save to discard your changes or Cancel to keep the 
current window open. 
 
Deleting Data 

 
Click Delete to delete the currently selected item. The Delete icon will appear in 
the toolbar of virtually every screen within STX. 
 

 
A delete confirmation sheet will appear. Each one will contain a message specific 
to the item you are trying to delete. If you wish to continue with the deletion, click 
the Delete button. Click Cancel to keep the current information intact. 
 
The type of message you will receive is dependent on what item you are trying to 
delete. Deleting an appointment will yield a different type of message than 
deleting a product or service will. If the message says the item is in use, consider 
making the item Inactive instead. STX does not allow the deletion of items in use 
by other data. Please see information about making items Inactive found 
throughout the Setup chapters of this manual.  
 
A few examples of the types of messages you might see in the delete 
confirmation sheets are below. 
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In Use 
The following sheet will appear if the item you are deleting is in use by other data. 

 
Always click Cancel to keep the current window open, to allow you to uncheck 
the Active checkbox instead of following through with the deletion. 

 
 
Are you sure… ? 
The following sheet will appear if the item you are deleting is contributing to other 
data, such as client, appointment, and/or transaction history. 
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Using Objects 
Buttons can be clicked to perform a programmed action. Any button that is aqua 
in color is automatically selected and will be activated by pressing the Return key 
on your keyboard. 

 
Checkboxes are either checked or unchecked. Each checkbox is independent 
and multiple checkboxes may be checked together. 

 
Fields may contain text, dates or numbers with the program determining the type 
of data that may be entered into a field. 

 
Radio buttons allow for the selection of only one item from a group. 

 
Popup menu lists allow you to choose one item from the list. Click on the popup 
menu to display the list of available choices and then click on the desired item to 
select it. 
 
Column Headers 
You may temporarily change the column order, column sort and/or column size of 
certain lists. Note: The list will return to its default format when the window is 
closed. 

 
The Postal Codes screen defaults itself to the above. 
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Moving Columns 

 
Click on a column header and drag the column to a new location. The column will 
turn dark when you click on the header and move to the desired position. 
 
Sorting By Columns 

 
Click on a column header to sort the list in ascending order by that column. 
Notice the up arrow to the right of the Postal Code. NOTE: This feature is not 
available on lists that support drag and drop rearranging. 

 
Click on the column header a second time to sort the list in descending order by 
that column. Notice the down arrow to the right of the Postal Code. Click on the 
column header again and the list will return to its original order with no arrow. 
 
Resizing Columns 

 
Certain columns can be resized by clicking on the line to the right of a column 
name and dragging right to increase and left to decrease column size. The cursor 
changes to a double arrow when placed over a column line if this feature is 
available for the screen you are working in. 
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Copy & Paste 

 
Highlight the item you wish to cut and pull down the Edit Menu to Cut or use the 
keyboard shortcut. Cutting will delete the selected item from its original location. 

 
Highlight the item you wish to copy and pull down the Edit Menu to Copy or use 
the keyboard shortcut. Copying will leave the selected item in its original location. 

 
Place the cursor where you wish the item to go and pull down the Edit Menu to 
Paste or use the keyboard shortcut. Pasting will place a copy of the selected item 
at the cursor position. 
 
Editing Text 
To insert characters, click where you want to start and type the characters. To 
delete characters, click to the right of the characters you want to delete and press 
Delete as many times as necessary.  
 
To change a word, double-click the word to select it and type the new word. To 
delete a word, double-click the word to select it and press Delete.  
 
To replace several words, click where you want to start and drag to highlight. 
Once the words are highlighted, type the new words. To delete several words, 
click where you want to start and drag to hightlight. Once the words are 
highlighted, press Delete. 
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Opening Files 
The open dialog sheet allows you to move to and select a file you wish to open. 
The sheet will appear any time you need to find an image or picture file in STX. 

 
Clicking on the popup at the top of the sheet allows you to choose from a list of 
recent locations.  
 
Clicking on a vertical scroll bar arrow moves you up or down within a level of the 
finder. You may also drag the scroll bar or click between the scroll bar and the 
top or bottom limits.  
  
Clicking on a horizontal scroll bar arrow moves you left or right in the finder. You 
may also drag the scroll bar or click between the scroll bar and the left or right 
limits.  
 
When you find your file, click to highlight its name and click Open. Click on 
Cancel if you want to quit without choosing a file.  
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Saving Files 
The save dialog sheet allows you to move to and select a place you wish to save 
your file to. The sheet will appear any time you need to save a file from STX or 
STXAdminTool. 

 
Clicking on the popup at the top of the sheet allows you to choose from a list of 
recent locations.  
 
Clicking on a vertical scroll bar arrow moves you up or down within a level of the 
finder. You may also drag the scroll bar or click between the scroll bar and the 
top or bottom limits.  
  
Clicking on a horizontal scroll bar arrow moves you left or right in the finder. You 
may also drag the scroll bar or click between the scroll bar and the left or right 
limits. 
 
Click New Folder if you wish to create a new folder inside another folder/place to 
save the file(s) to. Make sure the popup menu is set to the desired folder/place 
for the item to be saved to. When you find the place you wish to save your file to, 
click to highlight its name and click Save. Click on Cancel if you want to quit 
without saving the file. 


